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Introduction
Workshare Professional is a desktop application that automates managing changes to business documents, protects
against unauthorized content disclosure and delivers the world’s most secure PDF creation, all in one integrated 
solution.

Workshare Professional is designed for the way that you work – within Microsoft Office. Workshare Professional 
integrates with your existing desktop productivity software Microsoft Word, Excel and PowerPoint and your email 
applications such as Microsoft Outlook or IBM Lotus Notes. In addition, many companies use Document Management 
Systems (DMSs) and/or Microsoft SharePoint to track and store key documents and Workshare Professional 
integrates out of the box with these.

Workshare Professional provides:

 Fast and accurate multi-party document review

 Elimination of version/master proliferation and confusion

 Fast and accurate document comparison including “one-to-many” comparison

 Policy-driven content risk management and PDF conversion

 Discovery and removal of hidden data and visible content leaks

 Ability for users to fix potential problems with manual redaction options 

 Secure PDF conversion anywhere and on email send

 Extended and secured document control over email and portals

 Accurate conversion of PDF files to Microsoft Word files

 Ability to combine multiple files into a single PDF

 Ability to generate a Redline (comparison) document from Microsoft Outlook

The Workshare Professional suite of products includes:

Workshare Compare The world’s leading and fastest comparison tool especially critical for complex business 
documents in any language with difficult to compare changes like tables, complex 
formatting, numbering and styles.

Workshare Protect Workshare's market leading and award winning client educates users as it enforces 
content security policy. Working both online and offline, the Workshare Protect client 
removes risky content, converts information to appropriate formats, and applies content 
rights. Workshare Professional also includes support for new Workshare server 
components that complement this advanced new Workshare Protect client.

Workshare Review The fast, accurate and secure way to review and exchange business documents. 
Workshare Professional Review eliminates version/master proliferation and confusion 
when sharing documents across email, portals, and document repositories and provides 
full document lifecycle audit and visibility.
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Workshare Professional Benefits and Features
Workshare Professional provides accurate and efficient review control, comparison, and security while automatically 
maintaining a single master document

 Advanced PDF and document comparison

Compare one document against multiple modified versions including Word to Word, PDF to PDF, and Word
to text-based PDF.

 Advanced and trusted accuracy

Accurately compare complex documents (100+ pages) for changes in text, embedded excel tables and 
images.

 Document redlining made simple

Email redlines as tracked changes or save redlines as a PDF document.

 Multiple comparison interfaces

Utilize the standalone document comparison tool or work within Microsoft Word.

 Alert and Compare

Generate Redline documents from Microsoft Outlook

 Manage and track document reviews

Give authors, delegates and reviewers an easy means to assemble, review and verify document changes.

 Single master tracking

Ensure the correct version of a document is under review by colleagues, clients and partners regardless of 
where the document is stored.

 One click PDF creation

Create a PDF with one click when attaching a file to an email or from within Microsoft Office applications

 Edit and collaborate on PDF documents

Convert text-based PDF documents into Microsoft Word for editing

 Combine PDF

Combine multiple files into a single PDF.

 Convert and compare image-based documents

Convert and compare scanned documents, images and faxes when used with the Workshare OCR Server.

 Remove sensitive information

Ensure total cleanup and removal of all hidden electronic information with metadata removal and redaction 
tools in Microsoft Office and PDF documents.

 One click email protection

As an alternative to the Workshare Protect Email Security dialog, simply click a profile to apply security to 
emails and their attachments.

 Classify documents

Easily restrict access to sensitive business documents by setting document classifications.
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 Detect confidential information

Utilize the Workshare Policy Designer to identify intellectual property or sensitive information such as 
financial data or passwords within email or Office documents.

 Full PDF security

Through policy rules your organization can enforce PDF creation with 128-bit encryption and restriction 
rules.

 Device control and USB port protection

Prevent sensitive data loss when used with the Workshare Device Protector.

 Audit and reporting

Track and report every document change made inside and outside of the organization.

What’s New in Workshare Professional 7 FP2
Workshare Professional 7 FP2 is a product quality release with improvements as well as extending DMS Support so 
that Workshare Professional is now certified for use with Autonomy iManage 9.0.

System Requirements
The certified environments for Workshare Professional are as follows:

Minimum System Requirements Intel Pentium 4 2.8GHz processor (XP) or Intel Pentium 4
3.2GHz processor (Vista/7) 

1GB RAM (XP) or 1.5GB RAM (Vista/7) 

1GB free disk space 

Recommended System Requirements Intel Core 2 DUO @ 2.2GHz 

AMD Athlon 64 X2 4400+

2GB RAM 

2GB free disk space 

Operating System:

 Microsoft Windows XP SP3

 Microsoft Windows Vista SP2 (32 bit and 64 bit) - UAC disabled 

 Microsoft Windows 7 (32 bit and 64 bit) – default UAC

 Microsoft Windows 7 SP1 (32 bit and 64 bit) – default UAC

Citrix:

The following Citrix environments are supported:

 Citrix Presentation Server 4.5

 Citrix XenDesktop 5

 Citrix XenDesktop 5.5 *



WORKSHARE PROFESSIONAL RELEASE NOTES

6

 Citrix XenApp 5

 Citrix XenApp 6

 Citrix XenApp 6.5 *

They are supported when running on the following:

 Microsoft Windows 2003 Server (32 and 64 bit) 

 Microsoft Windows 2003 R2 Server (32 and 64 bit) 

 Microsoft Windows 2008 Server (64 bit) 

 Microsoft Windows 2008 R2 Server (64 bit) 

Note: Check with your Citrix vendor about which Windows operating system supports your version of Citrix. 

Microsoft Office System:

 Microsoft Office 2010 (32-bit)

 Microsoft Office 2010 SP1 (32-bit)

 Microsoft Office 2007 SP3

 Microsoft Office 2003 SP3

Email System:

 Microsoft Outlook 2010 (32-bit)

 Microsoft Outlook 2010 SP1 (32-bit)

 Microsoft Outlook 2007 SP3

 Microsoft Outlook 2003 SP3

 IBM Lotus Notes 8.x

Other:

 Microsoft .NET Framework 4.0

 Windows Installer (x86), version 3.1.0.0 

SharePoint:

 Microsoft Office SharePoint 2010

 Microsoft Office SharePoint Server 2007

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports your DMS. 

 Autonomy iManage: 

 FileSite / DeskSite Client 8.2 SP2 (Patch 2a)

 FileSite / DeskSite Client 8.5 SP3 Update 4 *

 FileSite / DeskSite Client 9.0 Update 1 *

 Open Text: 
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 Hummingbird DM 5.1.0.5, ODMA (SR6)

 Hummingbird DM 5.2.1 ODMA and COM (CU6) 

 Hummingbird DM 6.0.5 ODMA and COM (CU4)

 eDOCS DM 5.3 COM only (Patch 2)

 eDOCS DM 5.3 COM only (Patch 4) *

 eDOCS DM 5.3.1 Update 1 COM only *

* Requires Workshare Professional 7 FP2

Note: Worldox integration is supplied and supported by Worldox.

Workshare will endeavor to support future service packs of certified environments.

Important Information
 Send For Review – If an error appears “Workshare Protect was unable to process this email” when Sending 

for Review a user is advised to restart Microsoft Outlook.

 Secure PDFs – Workshare Professional is unable to compare secure PDFs or convert secure PDFs to DOC 
format. Secure PDFs are PDF files with security settings configured.

 Licensing – If the product is licensed on subscription basis, one month before your subscription license 
expires, you can choose to receive a popup Expiry Notice on a daily basis. You can configure Workshare 
Professional so that the Expiry Notice is displayed/not displayed as required. For further information, refer to 
the Licensing Workshare Professional section in the Workshare Professional Installation Guide.

 Policies Not Triggered – When emailing password-protected .docx documents, default policies are not 
being triggered. This is due to the Microsoft Word Security Update KB969604.

Important Installation Information
 Workshare Professional installs program files to a sub-folder within the Workshare folder named Modules.

 Install: A user is unable to install Workshare Professional if Microsoft Windows Installer 3.1 is not installed. 
This can be downloaded from the following location http://www.microsoft.com/
downloads/details.aspx?FamilyID=889482FC-5F56-4A38-B838-DE776FD4138C&displaylang=en.

 Windows Vista: For MSI installs the user must have administrative privileges for the Default Mail Client.

 Internet Explorer: You must ensure that your email application is set as the default mail program in Internet 
Explorer. In Internet Explorer, select Internet Options from the Tools menu. In the Programs tab, select 
your email program (Microsoft Outlook) from the E-Mail dropdown list. If this is not done, you will not be able 
to send a document for review.

 Windows 7: When UAC is set to Default, running the Workshare Professional install displays the UAC 
prompt. You must approve the prompt and Workshare Professional will be installed. Running the Workshare 
Professional MSI silently will fail when UAC is set to Default because the user is not given the opportunity to 
approve the UAC prompt. Therefore for silent installs, disable UAC.

If you have installed any Alpha or Beta builds of Workshare Professional, we strongly recommend that you first 
uninstall them before installing Workshare Professional 7.
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Installing Fix Pack 2

Workshare Professional 7 Fix Pack 2 (Build 10000.5700) must be installed on top of Workshare Professional 7 or 
Workshare Professional 7 FP1. If you have a version of Workshare Professional prior to version 7, you should first 
upgrade to Workshare Professional 7 (Build 10000.1900) before installing FP2.

Change Requests Addressed
The following Change Requests have been addressed in Workshare Professional 7 FP2 (Build 10000.5700). Please 
note that some of these issues were specific to customer environments. For more information, please contact 
Customer Support.

TFS ID CR Number Description

4464 CR00157641 Title bar incorrect when viewing PDF created from WorkSite document.

4941 CR00163369
Blocked/Error in action sending PDF files with Extended ANSI/Unicode characters in 
the file name.

5304 CR00165744 Large table shown as completely deleted/inserted.

5307 CR00165746 Table deletions are marked as insertions when compared.

5522 CR00166062
‘Enable Attachment(s) Alert & Compare’ option freezes MS Outlook when Westlaw 
documents are received.

6005 CR00166204 PDF fields are removed when cleaned via Protect.

5371 CR00166207 Word crashes on startup when using the no document switch (/n).

5374 CR00166274 Unable to open document error when converting to PDF.

5700 CR00167243 Document type set to DEFAULT when saving Redline.

5703 CR00167249 Legal Size is not automatically detected when sending redline as PDF.

5049 CR00167721 Saving to DM using Profile on Send saves attachments in original state and format.

5756 CR00167927
‘The following error occurred while processing the email: An internal support function 
returned an error’ is displayed when sending an email.

5789 CR00168047 Payne Metadata Assistant crashes when Workshare COM Add-in is enabled.

5820 CR00168134
Unhandled error attempting to save a file to the collaboration when using custom date 
field.

5821 CR00168194 Document type field blank when saving Redline to DM.

5606 CR00168258
Style aliases created when Act on Changes document saved - when using act on 
changes on client documents, style names are getting style aliases.

5883 CR00168788 TOC in table causes comparison to complete in text-only (failsafe) mode.

5981 CR00169599
Cyrillic characters incorrectly displayed in Comparison Summary of Redline created in 
standard mode.
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TFS ID CR Number Description

6050 CR00169922 Outlook cannot be closed after changing phone settings.

6075
PDF document is not opened automatically though PDF is created using 'Create and 
View' button.

6177
Unhandled exceptions and errors are displayed while saving pdf and wwb files in 
folders for which write permission is denied (Office 2003 specific).

2842 CR00147574 Could not complete the operation error when creating Outlook Notes.

6188 CR00171076 PDF files sizes are increased when created using Workshare.

5889 CR00168482 Corrupt email message warning when send emails protected with RMS.

Important Known Issues
The following are known issues in the Workshare Professional 7 FP2 release - for more information, please contact 
Customer Support.

Compare

TFS ID Details

2705 Editing Redline Documents - DeskSite 8.5 SP2/Windows 7/Office 2010

The Local Save and Local Open options are not available when editing Redline documents from 
Workshare Compare. This issue is still pending investigation – please contact Workshare Support for 
an update.

3800 Saving Redlines Default Format – applies to Office 2003 & DOCX format only

When saving a Redline document to a DMS, a default format of .docx specified in the 
WorkshareConfiguration Manager is not remembered. The default format is always WDF.

4269 Unknown Action Displayed in Advanced Protect Dialog'Unknown' action is displayed by an 
attachment in the Advanced Protect Email Security dialog when the Alert & Compare action is applied.  
Emails are cleaned and sent as expected and without further issue..

4336 Ready Redline Document Tracking Action is Triggered in Advanced Protect DialogThe Ready 
Redline policy is displayed and applied even if the Alert and Compare feature is disabled. Emails are 
cleaned and sent as expected and without further issue.

4373 Workshare Compare – Autonomy iManage

When comparing documents from Autonomy iManage, the document paths displayed in the Modified 
Document dropdown list are incorrect - they point to a local temp directory instead of the WorkSite 
path.

4458 ABBYY OCR integration for Workshare Compare when comparing image-based PDFs

ABBYY OCR server settings applied as an admin user are used when comparing image-based PDFs 
as an admin user but are not used when working as a normal user.
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TFS ID Details

2705 MS Word Local Save and Local Open File Menu options missing after Edit Redline  – applies to 
iManage DeskSite 8.5 SP2/Windows 7/Office 2010

The Microsoft Word 2010 Local Save and Local Open options can disappear when selecting the Edit 
Redline option from Workshare Compare. It is possible to save the redline from Workshare Compare 
by selecting Save and choosing a Word redline save format.  This issue is currently under investigation 
– please contact Workshare Support for an update.

4473 'Unable to perform request : The worddocInfo..’ error occurs when comparing unsaved 
documents from inside MS Word

Error is displayed when the ’Launch comparison in Workshare Compare’ option is enabled and an 
unsaved document is selected to be compared from the Workshare Compare Versions option in MS 
Word.

4603 'The file you are opening is missing or corrupted’ error when comparing embedded documents 
– applies to .doc and Fast comparison mode only

An error message is displayed when comparing (using the right-click option) two DOC files where one 
file includes an embedded document.

4618 Rendering Set Option and Comparison Mode is not remembered from Home ribbon options

When comparing multiple files, the comparison mode and Rendering sets information may not be 
properly updated for each comparison from the comparison mode and rendering set Home ribbon 
options.

4721 Comparison fails to run from Workshare Panel

If the user has moved and docked the Workshare Panel and then performs a compare within Microsoft 
Word, the comparison is not produced. This issue doesn’t occur if the ‘Open in Compare’ option is 
checked.

4938 Workshare Compare – Window Synchronization and Navigation

When a modified document includes a change to the title, selecting this change in the Change 
Summary window may cause a loss of synchronization between the Source Documents and the 
Redline document.

5055 Upgrading to Workshare Compare 

After upgrading from Workshare Compare to Workshare Compare 7, 'Workshare Professional' is 
displayed in the Programs list in the Control Panel.

5092 Comparing - Long File Names

After comparing documents with long file names (76 or more) and selecting to email the Redline 
document, the user cannot drag and drop the Redline document to another email.

5093 Only Print Pages with Changes

If the Only print pages with changes option is selected when printing a Redline document, it is 
applied on subsequent print operations during the same session of Workshare Compare, for example, 
when sending the Redline document by email as a PDF file.

5099 Comparing – File Formats

The Change Summary display may present changes slightly differently depending on whether DOC or 
DOCX files have been compared.

5188 Compare - Detecting Changes

Data in a Word document that is changed to column format is not detected as moved from one place to 
another in the Redline document.
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TFS ID Details

5222 Compare – Table Auto Numbering

Table auto numbering changes are displayed in a Redline document as inserted/deleted rows rather 
than cell content changes.

5233 Convert to Track Change Document

When converting a Redline to a Track Change document, an extra section break and page at the end 
of the document are displayed.

5270 ABBYY OCR Configuration

ABBYY OCR server configuration is not included in Deployment Scripts saved via the Workshare 
Configuration Manager.

5480 'SolidPDFUseOCR' Registry option

’Workshare has detected an image-based PDF’..dialog appears when the 'SolidPDFUseOCR' 
Registry option  is set to 1 when comparing image-based PDF documents. Documents still compare as 
expected.

5518 Email Attachment Format

A user is able to send a Redline document as a PDF file when the Allow users to change email 
attachment format parameter is NOT selected  and the Default email attachment format parameter 
is set to WDF.

5535 Saving Redline Document – Document Description – applies to local file system documents 
only

When the Include document descriptions in the Redline file name parameter in the Workshare 
Configuration Manager (Integrations > General category) is disabled, it still displays document 
descriptions in the redline file name after comparing 2 local file system documents.

5536 Saving Redline Document – Document Location – applies to local file system documents only

When the Include document locations in the Redline file name parameter in the Workshare 
Configuration Manager (Integrations > General category) is enabled it doesn’t include the document 
location in the redline file name after comparing 2 for local file system documents.

5574 Comparing Password-Protected Documents

When comparing password-protected documents, a user is prompted for passwords before the 
comparison is performed and visible instances of winwords are created and not closed even after 
entering a correct password. 

5576 Rendering Set options on the Quick Access Toolbar

After adding the choice of rendering sets to the Quick Access Toolbar in Workshare Compare and then 
closing Workshare Compare, the rendering sets are not retained in the Quick Access Toolbar when 
Workshare Compare is re-launched. Workaround is to select the Rendering Sets drop-down menu 
which will display all the configured Rendering Set options.

5579 Compare – PDF Options

The Convert to PDF and Convert to PDF and Email options (Home ribbon, Actions group) are also 
available in the standalone Compare application. 

5627 Convert to Track Change Document – Tables

When converting a comparison to a Track Changes document, accepting/rejecting does not enable a 
user to shift cells, only to apply the cell contents.
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TFS ID Details

5676 Rendering Sets

Rendering set options are not retained after applying rendering set changes and re-running a 
comparison. Selecting a saved rendering set and re-running a comparison works as expected.

5826 Comparing TIF Images

The Redline may not display TIF images correctly when included in fields in headers.

5902 Edit Redline/Convert to Track Change Document

Tooltip not displayed when hovering over _REF fields after editing a Redline or when using Convert to 
Track Change Document.

5983 Compare from Word – applies to Office 2007 only

When comparing from within Word, an extra blank word document is opened.

6042 Saving WDF files to iManage WorkSite

After saving a comparison as .WDF, leaving the comparison open and then attempting to resave the 
comparison as a new version in Worksite results in a ‘Do you want to save document to disk?' 
message being displayed.

6044 Autonomy iManage - Open in Word

An error is displayed when opening a PDF document into Word from an Autonomy iManage server 
which contains \ / : * ? " < > | symbols in the file name.

6174 Paragraph alignment in redline view

Fully justified numbered paragraphs may change to left-aligned in the Redline document.This only 
occurs in the comparison TER view in Workshare Compare. Saving the redlne opening or editing the 
redline in MS Word displays paragraph alignment correctly.

6175 OCR – Comparison Mode

The comparison mode may not be updated correctly after running an image-based PDF comparison, 
saving the comparison as a .wdf file and then re-running the comparison in a different mode.

6191 PDF Forms

PDF form documents may result in incorrect rendering of certain document elements 

6211 iManage Filesite Servers appear twice in Save dialog

When saving a comparison to iManage Filesite,and clicking the ‘Logged in Servers’ combo box,  the 
Interwoven server name is duplicated (listed twice) 

6347 Compare – Convert to PDF

The PDF dropdown is not disabled in the Workshare Compare window, even though the Convert to 
PDF option is disabled in the Workshare Configuration Manager.

6348 OpenText DMS

A 'cannot save as new subversion for this document ( 0x801d000f)' message is displayed when saving 
a Redline document as a subversion for the second time to an OpenText DM server.

6567 Redline Statistics

When the Display comments in redline option is enabledredline statistics may not be displayed if a 
word in the document is being hidden by a comment 
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Protect

TFS ID Details

2016 Ink Annotations – Windows XP SP3/Office 2003 SP3 and 2007 SP2

When discovering content risk and cleaning open documents, ink annotations are also being cleaned, 
when selecting to clean comments. When discovering content risk in an Excel file. Comments are not 
discovered as risk elements when the document also contains Ink Annotations, however they are cleaned.

2036 Digital Signatures – Office 2007

An ‘error in action’ message is displayed when sending digitally signed Word documents externally.

2207 Converting to PDF - DeskSite client 8.0/8.2 connected to Worksite Server 8.5

A ‘failed to relate’ error message is displayed when right clicking a server document and converting to 
PDF and then selecting to save as a related document.

2587 Emailing Templates – Office 2007/2010

When the Display Send with Protect button configuration parameter is selected 
(Protection>Administration), the Email Security dialog is not displayed when sending Office 2007/2010 
templates (dotx/potx/xltx) internally or externally.

3059 Password Protected Excel File

The Document Risk Report fails to generate and a ‘navigation to the webpage was canceled’ error 
occurs when performing Content Risk on a password-protected Excel spreadsheet.

3418 Zip Action

When a zip action is triggered, the attachments to an email are zipped individually instead of being 
zipped into a single zip file.

3630 Confidential Classification

An Alert action is not triggered when sending a document classified as Confidential using any of the 
profiles on the Protect Profile' dialog

3858 EML Attachments

The Workshare Protect Profile dialog or Email Security dialog is not displayed while sending EML 
attachments.

3860 Converting Very Large PPT/PPTX Documents to PDF

It may take Workshare a long time to convert very large PPT and PPTX files to PDF

3941 Discovering Content Risk in XML Files

When discovering content risk in an open XML document, the Content Risk page of the Workshare 
Panel is left blank and the Risk report that can be generated is also blank.

4053 Policy Designer

When Workshare Protect is configured, via the Policy Designer, to zip files that are over a certain file 
size, sending multiple files of over and below the limit set will result in Workshare Protect zipping all of 
the attachments.

4391 Ink Annotations – PPTX

An ‘error in action’ message is displayed when sending PPTX files with ink annotations to external 
users.
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TFS ID Details

4429 Policy Designer - Lotus Notes

When a  zip action is configured via the Policy Designer and multiple files are sent using Lotus Notes, 
the zip action is not applied to the files. 

4452 Apply Password to Zip

An ‘error in action’ message is displayed when clicking send on the Protect Profile dialog if the Apply 
password when creating zip files parameter is selected in the Workshare Configuration Manager 
(Protection > Compress as Zip category).

4471 PDF Security Settings

When using Workshare to create a PDF and apply security settings, the PDF security settings are lost 
after sending the document to external users and opening it in certain PDF readers i.e. Adobe X

4543 Email Security dialog while discovering risk

An ‘error in action’ message is displayed when emailing a large number of attachments, if the Email 
Security dialog while discovering risk parameter is selected in the Workshare Configuration 
Manager and Cancel is clicked during Dynamic Discovery.

4599 Workshare PDF Publisher - PowerPoint

When printing a PowerPoint file to the Workshare PDF Publisher, the text - Microsoft PowerPoint - is 
added to the filename on the Save dialog.

4688 Clean Before PDF

When right clicking and converting to PDF, the metadata elements under Cleaning Options- Advanced 
Options on the Workshare PDF Security Dialog are unchecked by default even though the Clean 
before PDF parameter is selected in the Workshare Configuration Manager (Protection > Convert to 
PDF category).

4876 Headers/Footers – Excel 2007 and 2010

When cleaning headers and footers from an Excel file, the first page headers/footers and even page 
headers/footers are not cleaned.

4879 Hyperlinks in Endnotes/Footnotes

When discovering Content Risk, Hyperlinks present in Endnotes and Footnotes are not detected in 
DOC and RTF files only.

4908 Links - Windows 7 SP1/Office 2010 SP1

OLE Links in XLSX files are discovered twice in the Content Risk report.

4922 Smart Tags - Office 2010 only

Smart tags are not cleaned from Word documents.

4997 Lotus Notes -Island Mode

A Lotus Notes error 'invalid recipient detected' is displayed when selecting  any contact present in the 
Local address book (or Personal address book) and clicking Send, whilst in Island mode. 
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TFS ID Details

4998 Redemption DLL

Installing Workshare Professional 7 over Workshare Professional 5.2 SR3 FP3 removes the Registry 
keys pointing to Redemption.dll (version 4.8) which affects the ability to use the EMM toolbar or search for 
documents in the DMS. 

Note: Re-registering the Interwoven Redemption.dll (regsvr32.exe "C:\Program
Files\Interwoven\WorkSite\iOutlook\redemption.dll”) restores the registry keys and EMM toolbar 
functionality.

5067 Delete White Text – DOC

An “error in Action” message is displayed when clicking on the Protect Profile dialog and sending a 
DOC file that has a colored background and a Table of Contents with white text (if the Delete text with 
same color as background parameter is selected in the Workshare Configuration Manager 
(Protection>Remove Metadata).

5280 Lotus Notes Policy Settings

Policy settings deployed via the Registry are not applied to the runtime policy files even after re-
launching Lotus Notes multiple times.

5284 Hyperlinks - Word

Hyperlinks are cleaned from Word documents when performing PDF Combine or Batch Clean even 
though the Exclude field codes with hyperlinks parameter is selected in the Workshare 
Configuration Manager.

5408 Skip Cleaning – XLS

An 'error in Action' message is displayed when sending a password-protected XLS document to 
external recipients and choosing to ‘Skip’ cleaning.

5494 Convert to PDF – Create and View

The Create and View button is always enabled on the Convert to PDF dialog even though the radio 
buttons for choosing a save location are not selected.

5523 Emailing PDFs - Outlook 2010

The Workshare ribbon with the Compare Attachment with Workshare option is not available when a 
PDF document is opened and sent using the File > Attach to Email option. 

5541 Cleaning Password-Protected Documents - Outlook 2010

When email is created using either File > Save & Send > Send as Attachment or right-click > Send To 
> Mail Recipient and attachments include Office 2007 document + Office 2003 document + 
password-protected document (in that order), when the email is sent to external recipients, the 
password-protected document is not cleaned.

5559 Save After Clean - Excel

After cleaning content risk from an XLS/XLSX file a user is not prompted to save the document when 
closing it, unless headers/footers were also selected and cleaned. 

5570 PDF Anywhere

When printing to the Workshare PDF Publisher and selecting Concatenate on a document with 
markups, Word becomes unresponsive.
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TFS ID Details

5675 Workshare PDF Publisher

The contents of the original PDF are not concatenated accurately after updating Amyuni Driver to 
version 450. Additionally, when using the PDF Combine feature the documents are not combined 
accurately and they are overwritten.

5706 Save as PDF

A  ‘failed to run act on changes’ message is displayed after saving a Redline document as a PDF and 
then selecting Edit Redline from the Review tab.

5708 Content Risk - PowerPoint

When discovering Content Risk in a password-protected PowerPoint presentation, the Document Risk 
Report fails to generate and a Blank Content Risk Report is displayed.

5715 Different Error Messages

Different error messages are shown when sending a document using Send for Review and using Send 
to email recipient.

5780 Convert to PDF

‘There was an error opening this document. This file cannot be found.’ message is displayed by Adobe 
Acrobat when clicking the Create and View button and saving the PDF to the server the very first time 
a user converts to PDF; subsequent tries do not result in the error. The PDF is created however and 
can be opened if you select and open it manually.

5897 Sending PDF

When opening a PDF and clicking on File->Attach to email an email is generated correctly with the 
attached PDF. After attaching additional Office documents and clicking Send an ‘unknown file type’ 
icon is being displayed for PDF files in the Advanced Email Security Options dialog.

6049 Emailing XLSX Files

A ‘content discovery failed’ message is displayed from the Protect client, when sending emails with 
xlsx attachments that have already passed through Workshare Protect Server.

6090 Content Risk - Excel

Small text and white text in the header\footer of an Excel document are not displayed in the content 
risk report.

6095 Lightspeed Clean – Office 2010

After batch clean, an .XLS/.PPT document is opening in protected mode.

6096 Convert to PDF

Users are still able to save locally when converting to PDF with Workshare with Local File Store 
disabled. If a user tries to save locally they receive the message "error HRESULT E_FAIL has been 
returned from a call to a COM component."

6101 Hyperlinks

There are issues relating to the discovery of hyperlinks when performing content risk discovery. 

 Hyperlinks are not discovered in Smart Art graphics in .ppt/.pptx documents.

 Hyperlinks are not discovered in Drawings in .doc documents. 

 Inserted objects are displayed as Links twice in Excel sheets and cannot be removed from 
content risk.

 Hyperlinks for Images in .xls/.xlsx/.xlsm files are not being discovered in Content Risk.
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6102 Content Risk

Small text/Track Change/Hidden Text and White Text. field codes are shown as two/three risk 
elements in the content risk report whereas they should be displayed as one risk element

6117 Lightspeed Clean – Office 2010

Ink annotations are not cleaned during batch cleaning for .pptx files when Lightspeed Clean is enabled.

6176 Content Risk

Bitmap images and package objects are not detected in the content risk report.

6313 Send Without Processing

The Send without processing option is displayed when right-clicking the Send button in the Workshare 
Protect Profile dialog even though ‘Allow users to skip metadata removal ' option is disabled in the 
Workshare Configuration Manager.

6410 Send and Protect - Office 2010

The Send and Protect button is still enabled when a user opens an attached .msg filel from the Inbox 
or Sent Items folder. If the Send and Protect button is clicked observe that 'Error Sending Email’ 
message is displayed.

6418 Convert to PDF

Errors are displayed when clicking the Cancel button on the Printing dialog when converting a 
document to PDF or printing a document using the Workshare PDF publisher.

6424 Lotus Notes - Docx

A .docx document becomes corrupted and a message 'the file all risk elements dox cannot be opened’ 
is displayed at the recipient side, if a previously saved .wdf' comparison is emailed from Workshare 
Compare along with the original and modified documents.

6514 Password-Protected Zip Files

Password-protected zip files that contain unsupported file types i.e. txt files cannot be processed and 
sent as the password dialog reappears even after the password has been entered.

6515 Sending Emails

The Advanced Email Security Options dialog is displayed, rather than the email being sent, after 
clicking the Skip button when sending a password-protected .doc or pdf file to an external recipient, 
using the Clean or Clean and PDF profiles.

6581 Policy Designer – Lotus Notes

Documents are not zipped into a single zip file, but remain as normal documents, even though Group 
all files to a single archive option is selected.

6583 Policy Designer – Password Protection

When combining multiple documents into a single zip and choosing to password protect each file 
individually, the password parameters of the first document are applied to the rest of the documents 
irrespective of individual password parameters applied to them.

6649 Password-Protected Document

An ‘error in action’ message is displayed after clicking the Skip button on the Password Prompt dialog, 
when sending a password-protected .doc file with custom properties to an external recipient. 
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6744 Delete Document Reviewers

Using the clean metadata option Delete Document Reviewers enables the Remove Personal 
Information option in a Word document.

6779 Emailing with an Open Attachment

When clicking Send on an outbound email with multiple attachments that has already has an 
attachment open the user is prompted with a standard Outlook warning ‘The attachment is opened…’ If 
the user clicks Yes on this dialog and then clicks Send on the Protect Profle dialog the Outlook warning 
appear again. Clicking No on the Outlook warning this second time results in an ‘Operation aborted’ 
message from Workshare Protect.

Review

TFS ID Details

2024 Importing Responses - Lotus Notes

The Intelligent Import dialog does not display when opening response attachments from the 
Attachment menu. 

4303 Review Report

Details about the reviewed document are overwritten in the Review report making it difficult to read.

4309 Applying Changes - Office 2010

When the Display location arrows when navigating changes (requires restart of Word) parameter
(Review > Administration category) in the Workshare Configuration Manager is NOT selected) the 
alternate popup balloon is NOT displayed over the change in the original document.

4380 Apply Change Markers

The Apply Change marker images are not displaying correctly in the Redline document.

4450 Combine PDF

The right-click Combine files in Workshare option is not available for shared folders.

4496 PDF to Word

Chinese characters are not rendered correctly in Word when a PDF is converted to Word.

5024 Intelligent Import Displayed Twice

When you select Open Modified Copy in the Modified Copy dialog and click OK, the Modified Copy
dialog is redisplayed. Clicking OK for the second time displays the modified document correctly.

5028 Opening Response – Lotus Notes

When right-clicking a response document in Lotus Notes and selecting Open, the Modified Copy dialog 
is not displayed.

5282 Open in Word with Workshare

Garbage text is displayed when opening a PDF with a Unicode file name using the Open in Word with 
Workshare option.

5436 PDF Combine – Password-Protected PowerPoint Files

When combining password-protected PPT/PPTX files into a PDF using PDF Combine, the password 
prompt dialog is displayed behind the Combine Files dialog.
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5444 PDF Combine – Password-Protected Word Files

When combining password-protected DOCX files into a PDF using PDF Combine, an error is displayed 
when a page range is selected.

5678 Manage Changes

“The directory name is not valid…” error is displayed when the Open Original and Manage Changes
option is selected in the Modified Copy dialog.

5693 Enable Send for Review Parameter

When the Enable Send For Review parameter in the Workshare Configuration Manager (General > 
User Interface category) is disabled, it is still available as an option in the right click menu.

5744 Send for Review - Lotus Notes

When a document is sent for review, the document name is appended to the original document n the 
review mail.

5776 Automatic Import – Password Protected .doc files

The password prompt dialog is not displayed while opening a modified document from the Modified 
Copy dialog during automatic import.

6562 Reports

After generating an Audit report or a History report, the Document report for field is shown as 
'unknown' for unsaved documents.

SharePoint

TFS ID Details

4010 SharePoint and the Workshare Configuration Assistant

When SharePoint is set as the default document provider, a Workshare dialog asking for the paths to 
SharePoint sites is displayed when running the Workshare Configuration Assistant as a Normal user.

4331 SharePoint Profiling

When Workshare Compare is integrated with SharePoint and you save a Redline document into a 
location that requires profiling, the profile dialog blue title band is drawn incorrectly.

4617 Send for Review and SharePoint – SharePoint/Office 2010

A “failed to import” error message is displayed when clicking on the Import Responses and Manage 
Changes option when importing responses from SharePoint after sending a document for review.

4984 Saving Redlines to SharePoint

When saving a Redline document to SharePoint does not use the default format specified in the 
Workshare Configuration Manager is not used

5363 Classify – SharePoint

A ‘Manage changes functionality is not supported for this document management system’ error is 
displayed when clicking Classify for SharePoint server documents.

5458 Link to SharePoint – Password-Protected Files

An email is not generated when sending a password-protected Word document for review and linking it 
to SharePoint. 
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5459 Send for Review – Link to SharePoint

When sending a document for review and selecting to link the document to SharePoint, the left pane of 
the Workshare SharePoint Browser dialog that is displayed is empty. 

5460 Send for Review – Link to SharePoint

When sending a document for review and selecting to link the document to SharePoint, the querying to 
SharePoint progress bar is still displayed in the background even after the Workshare SharePoint 
Browser dialog is displayed.

5519 Convert to PDF – SharePoint

The file name is not populated by default in the save dialog when converting server documents to PDF. 

5521 SharePoint Unicode Documents

When comparing Unicode documents that have been uploaded to the server, the filenames of Unicode 
documents are not shown correctly in the title of the Compare window. 

5602 Saving Redline to SharePoint

An ‘unknown’ error is displayed when saving a comparison and overwriting existing WWB/WDF/PDF 
files after enabling the Profile New Documents option.

5995 SharePoint Documents

The Compare option is not available in the Workshare Panel after opening a previously linked 
SharePoint document, editing it and saving it back to SharePoint.

6057 SharePoint – Send for Review

The email is not generated when a WDF/WWB file is attached as an additional document to the send 
for review document.

6058 SharePoint – Send for Review

An extra document is created on the SharePoint server for additional documents that are attached from 
the Send Draft for Review page of the Workshare Panel.

6060 SharePoint – Compare

The Compare option is not available on the Workshare Panel after uploading a Unicode Word 
document into the SharePoint server.

6085 SharePoint – Send for Review

When editing the path in the navigation bar of the Link to SharePoint dialog and clicking Refresh, it is 
not possible to navigate to the specified location.

6088 SharePoint - Compare

An extra version is created when saving comparisons to SharePoint or combining files from 
SharePoint.

6107 SharePoint

A ‘failed to import’ error is displayed when selecting the Import response and manage changes
option from the SharePoint dialog during automatic import.

6127 SharePoint – Send for Review

Text is missing in cover page document after sending for review and linking document into SharePoint.
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6157 SharePoint – Compare from Word

After running a comparison within Word, the SharePoint Manage Changes dialog is displayed when 
sending the comparison to an internal recipient.

Other

TFS ID Details

3454 Licensing with Proxy Server

It is not possible to license Workshare Professional using proxy server settings.

4315 Locking Configuration Options

When locking configuration options as an admin user and applying them to the current user, the 
configuration options are still locked for other users of the machine.

4356 User Override

Deselecting the Allow users to override option values parameter in Administrator Mode is not 
correctly disabling user abilities to modify parameters in User Mode.

4454 Workshare Compare Keyboard Shortcuts

In Workshare Compare, the Ctrl + A shortcut is shown for both the right-click Select All option and the 
Save As option. In fact it is the shortcut for the Save As option.

4698 Installation

The Workshare installation does not resume after rebooting during the install process when necessary.

4875 Workshare Configuration Manager - Deployment Icon

In Administrator Mode, when clicking the padlock icon to unlock/lock a parameter the green arrow 
deployment icon is not being created.

5358 MS Excel

When the Workshare Panel is toggled on, opening multiple Excel spreadsheets shows reduction in 
size and unexpected overlapping.

5488 Citrix Professional Enable User

Workshare functionality is NOT restored in Excel documents after running the 
"CitrixProfessionalEnableUser" Registry key. Workshare functionality is restored in Word and 
PowerPoint documents.

5782 Uninstall

Workshare is not uninstalled correctly when uninstalling using the /uninstall switch for the Workshare 
Configuration Assistant.

5830 Install Error

An ‘internal error 26352 – 2147024891’ message is displayed when installing Workshare and pushing 
out the security certificate through the Domain Controller group policy.

6056 Professional.Options.Exporter.Launcher – Turkish Regional Settings

After an administrator has configured Professional, a ‘Professional.Options.Exporter.Launcher has 
stopped working’ error is displayed when a normal user launches Outlook.
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6116 Workshare Configuration Manager - Compare

The values set for the Number of Characters shown around... and Zoom(%) parameters are not 
retained as expected in the Workshare Configuration Manager.

6167 West Case Timeline

A ‘runtime error – 2147188160 (80048240)’ message is displayed when sending PowerPoint files if
West Case Timeline is installed.

6172 Workshare Configuration Manager – Content Risk

Certain Content Risk metadata elements may be incorrectly available in the Workshare Configuration 
Manager.

6365 Workshare Configuration Manager - Print

Print options locked in the Workshare Configuration Manager (Administrator Mode) are not disabled in 
the Print dialog.

6701 Workshare Configuration Manager - Protect

Options in the Remove Metadata sub-category in the Workshare Configuration Manager (User Mode) 
can be enabled/disabled even though Allow Users to override options value is deselected in 
Administrator Mode.

Contact Info
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